
1 
 

BEYOND DISABILITY 

 

 

 

Laptop and desktop PC manual.              

 

Oct 2016 

 

 

 

http://bdi.org.au/
http://bdi.org.au/


2 
 

          Rev:  July 2017. 

An introduction to the basics of your new Beyond Disability laptop or computer. 

            [Additional user tips are included in the appendix…section 16 is very important] 

Section                   Index. 

1.                       Laptop overview. 

2.                      Main preloaded programs and typical desktop screen display. 

3.                      Connecting to the internet. 

4.                      Google. 

5.                      E mails - Thunderbird. 

6.                      Word (or libre office writer). 

7.                      Skype. 

8.                       Team viewer. 

9.                       Sun clock. 

10.                      VLC – music and video player. 

11.                      Other preloaded programs. -listing only (tutorials planned for a future date). 

 

                   Appendix. 

12.                       How the keyboard keys work. 

13.                       Skype—the basics. 

14.                       Thunderbird—the basics. 

15.                       Tips for working/using the keyboard safely. 

16.                       How to protect your files and data. 

17.                       Some windows 10 tips. 

 

1. Laptop overview. 

The screen should look similar to the example below (desktops will also have very similar 

keyboards and screens), when first started (or booted) up. 

Typically this takes about 1 to 2 minutes. 

If it takes longer, or if it is dramatically different or appears to have frozen (unresponsive to 

mouse or keyboard), do the following: 

 Reboot (press and hold the power button for about 7 seconds) to get the laptop to shut down. 

Then once it has shutdown (no lights remaining lit (except for the laptop charging light – if the 

charger is connected) and no fan noise), then briefly press the power button again to restart the 

laptop. If rebooting fails to solve the problem we urge that you contact your assigned Beyond 

Disability Volunteer for help. 
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Side views of typical BDI laptop. 
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2.                             Main Preloaded programs. 

Note: whenever ΨŎƭƛŎƪ’ is mentioned below, it means clicking the mouse left button. 

 If you accidentally click the right mouse button, no harm is done – a new menu is simply opened up.  

You can close this menu by simply moving the mouse arrow to a vacant spot on the desktop and left 
clicking it.  

For further keyboard details refer to appendix at end of this document. 

A typical desktop 

 

Legend for the above display. 

1. This is the Windows start icon – click to access all programs  

2. Thunderbird icon. 

3. Internet Explorer/browser. This is set to the same setting as google (11). 

4. Windows Explorer – lists the contents of the laptop hard drive. 

5. Windows media player – play music – an alternative media player is called VLC (see 

13below). 

6. Word – program for writing. 

7. Telstra broadband. 

8. TeamViewer – allows BDI volunteer to repair laptop. 

9. Ccleaner – program for cleaning up old unused files. 

10. Skype – video or phone calling to other laptops/computers. 

11. Google – internet browser –alternatively you can use internet explorer (see3 above). 
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12. Sun clock – world map display showing world times – useful for overseas Skype calls. 

13. VLC – music and video, movies player – better than windows media player (see 5 above). 

14. Firefox – internet browser – similar to google. 

15. Rubbish bin – drag and drop unwanted items here for deleting. 

16. This is where any internet downloads are placed – can relocate them if desired. 

17. My documents – suggested place to keep items e.g., files, documents, pictures, videos etc. 
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3. Connecting to the internet. 

Depending on the type of internet modem you have been given one of the followingmenus 

shouldinitially appear on the desktop. 

 It will say ‘not ready’, ‘connect now’ or ‘not ŎƻƴƴŜŎǘŜŘΩ as in the pictures below. 

 

To connect, click on the box with ‘not connected’ and the after a few seconds the box should say 

‘connected ‘as per the screen below. 

This means that you are now connected to the internet. 
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Screen shot of the Telstra pre paid broadband: 

 

Screen shot of the Telstra 4G pre paid broadband: 
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4. Google. 

When the internet is connected, you can then click theGoogle icon (see item 11 in the screen shot in 

section ‘2 – main preloaded programs’ above) with the mouse left button and the following default 

BDI screen should appear within a few seconds. 

 

To go to the Googlehome page screen click on the Google icon highlighted above. 

The Google screen should now appear as below. 
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Now you can simply type any query or thought into the message box and when you press the enter 

button, a listing of related topics will appear after a few seconds as below. 
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5.    E mails - Thunderbird……...is the BDI recommended email program. 

 Access it by clicking on the Thunderbird icon on the desktop task bar. The Thunderbird screen below 

should appear within a few seconds and it automatically download any new e mails…..depending on 

how many there are this could take from a few seconds to a minute or more. 

 

 

 

Legend. 

1. Get messages – click on this to download messages – usually not necessary as Thunderbird 

normally does this automatically. 

2. Write – click to open a new e mail to compose. 

3. Address book – click on this to open listing of your contacts. 

4. Reply – click to reply to a highlighted e mail (remember to first highlight the e mail – then 

click reply). 

5. Delete – click this to delete a highlighted e mail (Highlighted e mails usually have a darker 

background to aid identification). 

6. In-box- this is where unfiled received e mails are kept (both read and unread). 

Below the in box are folders where e mails can be filed under relevant headings. 

7. This is where the contents of a highlighted e mail are shown – if the highlighted e mail is 

double clicked then it willfill the display space for easier reading. 
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6.    Word. (also generally applicable to libre office writer) 

These 2 are the recommended programs for typing and editing documents. 

Photos and tables etc., can also be pasted into documents. 
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We recommend that the ‘save’ button is clicked on every few minutes to guard against an 

unforeseen laptop power failure or upset that could otherwise lead to loss of the composed but 

unsaved document. 

Clicking on ‘file’ opens up the following menu. From here you can print or open other existing 

documents as well as save a document to a chosen folder (you will be asked to nominate a folder 

when ‘save as’ is clicked), or the desktop.  

 

To close a window – click the cross (x) in the top right hand corner. 

To make it bigger or smaller – click on the icons shown below. To resize a window you need to hold 

the left button down while moving the corner of the window. When the desired size is reached, 

release the left button. 
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7.       Skype. 

 

8.     TeamViewer. 

Clicking the team viewer icon will bring up this menu.  

This is only used when, with your permission,  your assigned BDI volunteer needs to remotely access 

your laptop to address issues/fix problems. 
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9. Sun clock. 

If this program is installed (yellow icon of the sun on the taskbar, then clicking the icon gives this 

screen which is handy for telling the time at overseas locations. This can be useful when making calls 

using Skype. 

 

10. VLC- music and video movie player. 

 

This program is useful for playing music and watching videos or movies. 

Another program that has similar functions is windows media player. 
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11. Some additional preloaded programs (accessed by 

clicking windows start button and  

ǘƘŜƴ ǎŜƭŜŎǘƛƴƎ Ψŀƭƭ ǇǊƻƎǊŀƳǎΩύ: - listing only. 

¶ PowerPoint 

¶ Excel 

¶ Paint. 

¶ Games. 

 

Appendix. 

12.           How the keys are organized 

The keys on your keyboard can be divided into several groups based on function: 

¶ Typing (alphanumeric) keys. These keys include the same letter, number, punctuation, and symbol 
keys found on a traditional typewriter. 

¶ Control keys. These keys are used alone or in combination with other keys to perform certain 

actions. The most frequently used control keys are Ctrl, Alt, the Windows logo key , and Esc. 

¶ Function keys. The function keys are used to perform specific tasks. They are labelled as F1, F2, F3, 
and so on, up to F12. The functionality of these keys differs from program to program. 

¶ Navigation keys. These keys are used for moving around in documents or webpages and editing 
text. They include the arrow keys, Home, End, Page Up, Page Down, Delete, and Insert. 

¶ Numeric keypad. The numeric keypad is handy for entering numbers quickly. The keys are grouped 
together in a block like a conventional calculator or adding machine. 

The following illustration shows how these keys are arranged on a typical keyboard. Your keyboard 
layout might be different. 
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Typing text 

Whenever you need to type something in a program, e-mail message, or text box, you'll see a 
blinking vertical line (|  ) called the cursor or insertion point. It shows where the text that you type 
will begin. You can move the cursor by clicking in the desired location with the mouse, or by using 
the navigation keys (see the "Using navigation keys" section of this article). 
 
In addition to letters, numerals, punctuation marks, and symbols, the typing keys also include Shift, 
Caps Lock, Tab, Enter, the Spacebar, and Backspace. 
 

Key name How to use it 

Shift Press Shift in combination with a letter to type an uppercase letter. Press Shift in 
combination with another key to type the symbol shown on the upper part of that key. 

Caps Lock Press Caps Lock once to type all letters as uppercase. 
 Press Caps Lock again to turn this function off.  
Your keyboard might have a light indicating whether Caps Lock is on. 

Tab Press Tab to move the cursor several spaces forward.  
You can also press Tab to move to the next text box on a form. 

Enter Press Enter to move the cursor to the beginning of the next line.  
In a dialog box, press Enter to select the highlighted button. 

Spacebar Press the Spacebar to move the cursor one space forward. 

Backspace Press Backspace to delete the character before the cursor, or the selected text. 

Using keyboard shortcuts 

Keyboard shortcuts are ways to perform actions by using your keyboard. They're called shortcuts 
because they help you work faster. In fact, almost any action or command you can perform with a 
mouse can be performed faster using one or more keys on your keyboard. 

 
In Help topics, a plus sign (+) between two or more keys indicates that those keys should be pressed 
in combination. For example, Ctrl + A means to press and hold Ctrl and then press A. Ctrl + Shift + A 
means to press and hold Ctrl and Shift and then press A. 
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Find program shortcuts 

You can do things in most programs by using the keyboard. To see which commands have keyboard 
shortcuts, open a menu. The shortcuts (if available) are shown next to the menu items. 
 

 
  
 
Keyboard shortcuts appear next to menu items. 

Choose menus, commands, and options 
You can open menus and choose commands and other options using your keyboard. In a program 
that has menus with underlined letters, press Alt and an underlined letter to open the corresponding 
menu. Press the underlined letter in a menu item to choose that command. For programs that use 
the ribbon, such as Paint and WordPad, pressing Alt overlays (rather than underlines) a letter that 
can be pressed. 
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 Press Alt + F to open the File menu, then press P to choose the Print command. 
This trick works in dialog boxes too. Whenever you see an underlined letter attached to an option in 
a dialog box, it means you can press Alt plus that letter to choose that option. 
 
Useful shortcuts 

The following table lists some useful keyboard shortcuts.  

Press this To do this 

Windows logo key  

 
 

Open the Start menu 

Alt + Tab Switch between open programs or windows 

Alt + F4 Close the active item, or exit the active program 

Ctrl + S Save the current file or document (works in most programs) 

Ctrl + C Copy the selected item 

Ctrl + X Cut the selected item 

Ctrl + V Paste the selected item 

Ctrl + Z Undo an action 

Ctrl + A Select all items in a document or window 

F1 Display Help for a program or Windows 

Windows logo key  

 
 + F1 

Display Windows Help and Support 

Esc Cancel the current task 

 
Using navigation keys. The navigation keys allow you to move the cursor, move  
around in documents and webpages, and edit text. The following table lists some common functions 
of these keys. 
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Press this To do this 

Left Arrow, Right Arrow, Up 
Arrow, or Down Arrow 

Move the cursor or selection one space or line in the direction of 
 the arrow, or scroll a webpage in the direction of the arrow 

Home Move the cursor to the end of a line or move to the top of a webpage 

End Move the cursor to the end of a line or move to the bottom of  
a webpage 

Ctrl + Home Move to the top of a document 

Ctrl + End Move to the bottom of a document 

Page Up (pg up) Move the cursor or page up one screen 

Page Down (pgdn) Move the cursor or page down one screen 

Delete Delete the character after the cursor, or the selected text; in Windows, 
 delete the selected item and move it to the Recycle Bin 

Insert Turn Insert mode off or on. When Insert mode is on, text that you type is 
inserted at the cursor. When Insert mode is off, text that you type 
replaces existing characters. 

 
Using the numeric keypad 

The numeric keypad arranges the numerals 0 through 9, the arithmetic operators + (addition), - 
(subtraction), * (multiplication), and / (division), and the decimal point as they would appear on a 
calculator or adding machine. These characters are duplicated elsewhere on the keyboard, of 
course, but the keypad arrangement allows you to rapidly enter numerical data or mathematical 
operations with one hand. 
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 Numeric Keyboard 

To use the numeric keypad to enter numbers, press Num Lock. Most keyboards have a light that 
indicates whether Num Lock is on or off. When Num Lock is off, the numeric keypad functions as a 
second set of navigation keys (these functions are printed on the keys next to the numerals or 
symbols). 
 
You can use your numeric keypad to perform simple calculations with Calculator. 
  
PrtScn (or Print Screen) 

A long time ago, this key actually did what it says—it sent the current screen of text to your printer. 
Nowadays, pressing PrtScn captures an image of your entire screen (a "screen shot") and copies it to 
the Clipboard in your computer's memory. From there you can paste it (Ctrl + V) into Microsoft Paint 
or another program and, if you want, print it from that program. 
 
Tip 

Press Alt + PrtScn to capture an image of just the active window, instead of the entire screen. 
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13.Skype -the basics. 

Skype, the popular Internet calling app, has been around for quite some time. The (mostly) free 
service launched in 2003, and has become one of the easiest and cheapest ways to stay in touch 
with others across the world. 

Whether you're travelling internationally or want to save money when calling others, Skype has 
become a great option because it's accessible through computers, phones, tablets, home phones, 
TVs and even devices like Xbox One. 

If it's your first time logging in, you may be asked to customize your settings, such as your language 

preference, and if you want Skype to launch when your computer starts. If so, check off "Run Skype 

when the computer starts." 

You'll also be asked if you want to install the feature "Click to Call," which is handy for when you 
want to call phone numbers listed on websites. Numbers across the web will be marked "free" if 
local businesses partners have decided to pick up the cost of your calls. This is especially useful when 
you're browsing the web and want to make a free call to a business. 

Next, you'll need to check if your audio and video equipment is working. If you skip over this step 
now, don't worry — here's how to adjust and check your settings at any time: 

 Go to "Call" and click "Audio settings." Below it, you’ll see "Video settings." 

Once you're in the settings page, here’s what to check for: 

¶ Make sure your speakers are on. If you can hear the Skype jingle, you're good. 

¶ Check that your voice can be heard through the microphone. If not, choose the appropriate 
microphone from the drop-down menu. 

¶ Check to see if your webcam is connected. If so, you should be able to see yourself on the 
live video feed. If not, check your video settings and make sure your webcam is plugged in 
correctly. 

Profile settings 

When setting up your account, you may have already been asked if you would like to change your 
profile picture. To change this and more, click on your name on the upper left-hand corner and all 
your profile settings will appear. You can edit your phone numbers, email addresses, country, state, 
gender, birthday, and add a blurb about yourself in "About Me." 

You can add as little or as much information as you want. The column on the right will display 
"Public" (information everyone using Skype can view), "Contacts only" (information your contacts 
can only see), or "Private" (visible to only you) for each field. If these words are grayed out, they're 
disabled, which means you cannot change the privacy setting. 

http://mashable.com/category/skype/
http://mashable.com/category/xbox-one%22
https://support.skype.com/en/faq/FA801/what-is-skype-click-to-call
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You’ll have to choose what information you want to share based on that privacy setting. For 
example, your country and state are public. If you aren't comfortable with sharing this information, 
ƛǘΩǎ ōŜǎǘ ǘƻ ƭŜŀǾŜ ƛǘ ōƭŀƴƪΦ 

 

If "Public," "Contacts only" and "Private" are grayed out, these settings are disabled and cannot be 
changed. 
 

Setting your mood 

You’ll notice that Skype has an "Add a mood message" option in your profile settings. The mood is a 
short message you can add to your profile to let your friends and family know what you’re up to or 
what you’re thinking. Similar to a status, you can post a comment, quote, a web link and more. 

 

You can add a short message about how you feel or what you're thinking in the "Add a mood 

message" field. 

Setting your status 
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You have the option to set your status to let your Skype friends know if you are available to chat. 
You can choose a status (online, away, not disturbed, invisible or offline) to show up next to your 
name. 

 Click "Skype" on the left-hand side of menu bar and select "Online Status." 

 

Set your status to let your Skype friends know if you are available to chat. 
 

5. Set general and privacy settings. 

 Go to "Skype" at the upper left-hand corner of the menu bar and select "Privacy." You’ll see a list of 
settings based on category on the left-hand side of the menu. 

Under "General" you can choose if you want to double-click on a contact to start a call, enable Skype 
to launch when your computer starts and more. 

To save yourself from dealing with unwanted calls and IMs, take a look at your privacy settings by 
selecting "Privacy." 
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A screenshot of Skype's privacy settings. 
 

Here, you can choose who can call and IM you, who can send videos and share screens with you, 
who can see your online status, and how long you want your chat history to stay. If you don’t want 
your profile details to be shared with advertisers, do not check off "Allow Microsoft targeted ads, 
including use of Skype profile age and gender." You can also manage your blocked people under 
"Block contacts." 

Then take a look at "Notifications" to choose which Skype alerts you want to receive. After this, you 
can adjust settings in the "Calls," "Messaging" (called "IM & SMS" on Windows) and "Advanced" 
sections to further customize your Skype experience. 

6. Add your contacts. 

Once you're in the Skype app, you'll see "Find your friends and say hello." You can search for your 
Skype contacts in your address book by selecting "Search address book." 
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Click "Search address book" to import your contacts. 

If you prefer to add Skype contacts manually, tap the "Add Contacts" button and enter your 

contact's name, Skype name or email address. Select the contact from the list of results that appear, 

and tap "Add to Contacts." You can edit the default contact request message, and click "Send." 

Those who accept your request will appear in your Contacts List. If there is a green check mark next 
to your contact's name, this means your contact is online and available. 

7. Message, call and video chat family and friends. 

Messaging 

To send and receive instant messages, click on a contact in your list and type in the text field where 
your cursor is. 

 

Send and receive instant messages by clicking on the contact's name in your list. To call, click the 

green "Call Phone" button and to video chat, click the green "Video Call" button. 

One of the advantages of Skype chat is that you can share photos, videos and files free of charge. 

Best of all, there is no size limit or limit to the number of files you can send or receive through Skype. 

To send a file, click the chat you want to send the file to, click the + button and select "Send file…" 
Then, browse and choose the file you want to send. Click "Open" and the files should be sent to the 
recipients in the chat. You can also just go to your contact list and right-click the person to whom 
you want to send a file. 

Skype recommends using an up-to-date antivirus software to scan files that are sent to you. To 
protect privacy, Skype says on its site that all files are "encrypted end-to-end just like Skype-to-Skype 
calls." 

Skype to Skype calls 

To place a call, click the "Call Phone" button next to your contact's name. 

To video chat click on the "Video Call" button, which is located to the left of the call button. 

https://support.skype.com/en/faq/FA3091/how-do-i-send-and-receive-files-using-skype-for-windows-desktop
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…………….this is your camera view          

                                                                                                          (Small picture bottom right hand corner)             

By clicking the green "Video call" button, you can video chat with other Skype users. 

Calls to mobile phones and landlines 

If you're calling a mobile phone or landline, it will cost money. The price of the call varies depending 
on where you call. You have two options: to purchase Skype credit or buy a calling subscription. Call 
rates are always the same, no matter where you're calling from. 

You can buy $10 or $25 worth of Skype credit  and you have the choice to enable auto-recharge, 
which credits the original amount you selected when your balances falls below $2.00. When you 
chat with a non-Skype user, you’ll see your balance decrease as it is being used. 

To manage your Skype credit balance, sign into Skype and tap your name in the upper left-hand 
corner of your home screen. If you have Skype credit, you’ll see the remaining balance next to your 
name. When you click on your name, it takes you to your profile settings, where you can purchase 
additional Skype credit or a subscription. 

 

If you have Skype credit, you'll see the remaining balance next to your name. 

In your profile settings, you will also see the choice to upgrade to a Premiumaccount. Group video 

calling, which used to be the highlight of Skype Premium, is now free for all Skype users. Due to this, 

Skype Premium has been removed and is undergoing changes. 

 

http://www.skype.com/en/offers/skype-credit/?intcmp=CS-Upsell-FA1214-1
http://www.skype.com/en/rates/?intcmp=CS-Upsell-FA1214-2
http://www.skype.com/en/premium/?intsrc=client-_-windows-_-6.16.0.105-_-profile.premium
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14.Thunderbird     The Basics 

As soon as you’ve set up an email account, you’re ready to start sending and receiving messages in 
Thunderbird. Here’s how to do it. 

Sending a new message 

1. In the Thunderbird toolbar, click the Write  button. The Write window opens. 

 

 

2. In the To box, type the email address you want to send the message to. 
 

 

Tip: Thunderbird automatically saves email addresses in your address book that you've 

previously sent messages to. After that, Thunderbird autocompletes known addresses as you 

https://support.mozilla.org/en-US/kb/automatic-account-configuration
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type them. Just press Tab as soon as the right address appears – the address will be entered 

and you’ll be on to the next step already. 

3. In the Subject box, type the subject of your message. 
 

 

4. Type your message in the message pane. 
 

 

Tip: If HTML-formatting of composed text is allowed in account settings, you can customize 

the appearance of your message with Thunderbird’s word-processing functions in the 

Formatting Bar above the message pane. Smileys included!  
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5. Click the Send button. 

 

 

Note: Thunderbird saves copies of all your sent messages in a Sent folder. 

Receiving messages 

By default, Thunderbird checks for new messages every time you open the application. It will also 
automatically check again every 10 minutes, while the application is running. This behaviour for both 
actions can be customized (see below.) 

To check for messages at any other time, click the Get Messages button in the toolbar. 

 

Customizing how messages are sent and received 

Get Thunderbird flying the way you want it! Many settings can easily be customized. 

https://support.mozilla.org/en-US/kb/sending-and-receiving-messages-thunderbird#w_automatically-checking-for-new-messages
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Automatically checking for new messages 

Set how often you want Thunderbird to automatically check for messages: 

1. In the Thunderbird menu bar, click the Tools menu and click Account Settings, or click the 

Application menu button  and select Options and Account Settings from the sub-menu. 

2. On the accounts pane, click Server Settings beneath your account. 

3. Choose the time interval for checking in Check for new messages every setting. If you don't 
want Thunderbird to check automatically, uncheck this setting. 

4. To enable or disable automatically checking for new messages at startup, check or 
uncheckCheck for new messages at startup. 

5. Click the OK button to close the Account Settings window and to save your settings. 

Auto-saving 

When you’re writing a new message, your work is auto-saved every five minutes, but you can make 
it more often, or less: 

1. In the Thunderbird menu bar, click the Tools menu and click Options, or click the Application 

menu button  and select Options and Options from the sub-menu. 

2. Click the Composition panel. 

3. Click the General tab. 

4. Choose the time interval for auto-save in the Auto Save every setting. If you don't want 
Thunderbird to save automatically, uncheck this setting. 

5. Click the OK button to close the Options window and to save your settings. 

Sound alert for new messages 

Choose your own sound alert for new messages: 

1. In the Thunderbird menu bar, click the Tools menu and click Options, or click the Application 

menu button  and select Options and Options from the sub-menu. 

2. Click the General panel. 

3. Click the Use the following sound file option. 

4. Click the Browse… button. 

5. Choose your sound file and click the Open button. 

6. You can preview the sound file by clicking the Play button. 

7. Click the OK button to close the Options window and to save your settings. 

 

 

Marking messages as read 
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Thunderbird displays unread messages in bold type, marking a message read and in normal type as 
soon as you click on the message. If you don't like this behaviour, you can change the time interval 
before Thunderbird marks messages as read: 

1. In the Thunderbird menu bar, click the Tools menu and click Options, or click the Application 

menu button  and select Options and Options from the sub-menu. 

2. Click the Display panel. 

3. Click the Advanced tab. 

4. Click the After displaying for option and set how long Thunderbird should delay before 
marking a message as read. 

5. Click the OK button to close the Options window and to save your settings. 

Downloading incoming messages 

By default, Thunderbird will check your mail server(s) for new messages on application start up and 
then automatically as described earlier in this article. In addition to that, you can check for new 
messages manually at any time using several methods described below. 

To get new messages for the currently selected account: 

¶ From the Application menu button: 

o Click the Application menu button  . 

o Select File, then Get New Messages for and Current Account from the sub-menu. 

¶ Click the Get Messages button in the top left corner of Thunderbird's main window. 

¶ Use the keyboard shortcut. 

¶ Right-click the account in the folder pane and select Get Messages. 

¶ From the menu bar: 

o Click the File menu. 

o Select Get New Messages for and click Current Account from the sub-menu (where "Current 
Account" is the account highlighted in the folder pane). 

To get new messages for all accounts: 

¶ From the Application menu button: 

o Click the Application menu button  . 

o Select File, then Get New Messages for and All Accounts from the sub-menu. 

¶ In the Thunderbird toolbar, click the drop-down arrow of the Get Messages ᵽ button, and 

then select Get All New Messages. 

¶ Use the keyboard shortcut. 

¶ From the menu bar: 

o Click the File menu. 

https://support.mozilla.org/en-US/kb/keyboard-shortcuts
https://support.mozilla.org/en-US/kb/keyboard-shortcuts
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o Choose Get New Messages for and click All Accounts from the sub-menu. 

 

To compose a new message: 

¶ From the Application menu button: 

o Click the Application menu button  . 

o Select New Message and Message from the sub-menu. 

¶ Click the Write  button in the Thunderbird toolbar. 

¶ In the Thunderbird menu bar, click the Message menu and select New Message. 

¶ Use the keyboard shortcut. 

If an email (or newsgroup) account is highlighted in the All Folders panel, the messages Fromaddress 
will default to the selected account. If no account is specified, the from address will default to the 
first account configured in the Account Settings. Click the from drop-down list to select a different 
account. 

Specify one message recipient per line. Click the arrow in the field to the left of the recipient name 
to specify the type of recipient (for example, "To", "CC", etc.). 

To insert addresses from your address book, enter some of the characters from the person's name in 
the To field. A drop-down list will show all address book entries where the first or last name starts 
with the character(s) you entered, or entries where the string you entered exists. For example, if you 
enter "se", anyone in the address book with the last name of "Serrano", or "Casey"or the first name 
of "Sean", or "Jesse" would be displayed in the drop-down list. 

You can also drag and drop addresses from your address book to a new message. Simply open the 
address book, select the desired entry and drag it to the recipient area of the new message. 

Replying to a message 

To reply to a message: 

¶ From the Application menu button: 

o Click the Application menu button  . 

o Select Message and then Reply or Reply All when the message is displayed. 

¶ Click the Reply or Reply All button in the Thunderbird toolbar when the message is  

 

 
 
 

https://support.mozilla.org/en-US/kb/keyboard-shortcuts
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15.Tips for using your keyboard safely. 
 
 
Using your keyboard properly can help avoid soreness or injury to your wrists, hands, and arms, 
particularly if you use your computer for long periods.  
 
Here are a few tips to help improve keyboard use: 

¶ Place your keyboard at elbow level. Your upper arms should be relaxed at your sides. 

¶ Centre your keyboard in front of you. If your keyboard has a numeric keypad, you can use 

the spacebar as the centering point. 

¶ Type with your hands and wrists floating above the keyboard, so that you can use your 

whole arm to reach for distant keys instead of stretching your fingers. 

¶ Avoid resting your palms or wrists on any type of surface while typing. If your keyboard has a 

palm rest, use it only during breaks from typing. 

¶ While typing, use a light touch and keep your wrists straight. 

¶ When you're not typing, relax your arms and hands. 

¶ Take short breaks from computer use every 15 to 20 minutes. 
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16.Protecting your files and data. 

To protect your files and data in the unlikely event of a complete laptop failure we strongly 

recommend copying your files to a USB memory stick (also called flash drive). 

They come in many different styles (see picture of some types) but we recommend getting one with 

at least 8 gigabytecapacity (presently around $5). This should be large enough for most storage 

however if you have 1000’s of photos plus videos, songs etc., then a larger capacity might be 

needed.These are readily available, currently up to about 128 gigabytes.  

 

It can be a USB 1 or USB 2 or USB 3 (the higher the number the faster it goes but even the USB 1 

should work fine for most data). 

Copying files to the USB memory stick.  (daily is suggested or as desired) 

NB. We will be happy to demonstrate how to do this but one way is as follows: 

¶ With the laptop on, insert the USB memory stick into one of the USB slots on the side 

of the laptop (the USB stick will only go in one way).  

¶ A screen as in the picture below should then appear. 

¶ Left click on the ‘open folder to view files’ icon. 

¶ Use the mouse to go to ‘my stuff’ on the laptop desktop. 

¶ Holding down the left mouse button, drag the ‘my stuff’ icon into the open folder and 

let go the left button. All the files in the ‘my stuff’ folder should now be copying onto 

the USB memory stick. Depending on the number of files this could take up to several 

minutes. 

¶ If there is an existing backup there already simply click “yes” to ‘overwrite the 

existing folder’. 
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17.                  Some windows 10 tips.  

           As always, for help with any problems please feel free to contact your volunteer. 

1. Windows can be customised (we can set these up for you if desired ) so that: 

-  the content on screen can be read out you (the program is called ‘narrator’ 

- The screen content can be magnified. 

- The screen can be altered into a high contrast mode to make it easier to view. 

- The mouse pointer can be customised in various ways to make it easier to view. 

 

2. To put your own picture as a background on the screen: 

- Right click the mouse button on a blank part of the desktop. 

- Left click the last item “personalize” 

- Click the browse button and go to where the desired photo/picture is (possibly in my 

stuff/photos). 

- Click on it. That should be all.  

 

3. To find a misplaced file or photo or other item: 

- Right click on the windows icon (bottom left side of the task bar along the bottom of the 

desktop. 

- Left click ‘search’ 

- Type in the name of the item you are looking for. 

 

4. Recovering a deleted item: 

- Click on the ‘recycle bin’ icon (normally in the top left hand corner of the desktop) 

- Scroll down until you find the item and then drag it back onto the desktop (ie., put the 

mouse pointer on the item and, while holding the left button down, move the pointer 

onto the desktop and then release the left hand button). 

  


